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o Ciclo de Desarrollo

o Diagramas de Flujo
o La placa de Desarrollo STM32L-DISCOVERY

o Kl entorno de trabajo upVisionb
e Instalacion de uVisionbd
e Pasos para la creacion de un proyecto en pVisionb
e Pasos para la depuraciéon de un proyecto

o Ejercicios
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CICLO DE DESARROLLO HARDWARE

Idea del Programa Desarrollo de unJ "‘ Verif. Conexiones

© e, Prototipo (Timbrado)

Declaracion de l’
Especificaciones < Verif. Euncional >
— erif. Funciona
3 1
Diagrama de Bloques J / Desarrollo Placa C.|. J
Pinout y Esquematico _II < Verificacion >
de la Placa
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) CrcLo DE DESARROLLO SOFTWARE
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ENTORNO DE TRABAJO:
¢ DIAGRAMAS DE FLUJO

lopesaooidoldipy us sopeseg sajelbiq sewsalsiS  9T0Z/T0/ST




DIAGRAMAS DE FLUJO

o Son representaciones del funcionamiento de un programa
* De forma genérica — independiente de la arquitectura

o Nunca pueden contener referencias a registros de la
arquitectura utilizada, ni a instrucciones de la CPU

* Que muestran la soluciéon al problema planteado

e Que tienen que servir de guia, tanto al programador como a
los posibles programadores que tengan que tocar ese
programa

o Se pueden escribir a distintos niveles de
detalle/abstraccion

o El nivel de detalle que debe ser utilizado dependera de la
situacion

o Tradicionalmente se utilizaran solo los simbolos sencillos:

o Elipse o circulo, para indicar una etiqueta
» Rectangulo, para indicar un proceso
» Rombo, para indicar una decision
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DIAGRAMAS DE FLUJO: EJEMPLO

Programa que espera 2 segundos para encender un LED en la salida digital PA1
del micro y luego la deja encendida para siempre

| Enciendo

> Fin de
lasalidal —

programa

Inicializo
registros
necesarios,
el contador
y apago el
LED

Inicio de
programa




ENTORNO DE TRABAJO: LA PLACA
DE DESARROLLO STM32L.-
¢ DISCOVERY
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STM32L-DISCOVERY

KYI STM32L-DISCOVERY

STM32L ultralow power discovery board

Data brief

Features

m STM32L152RBT6 microcontroller featuring
128 KB Flash, 16 KB RAM, 4 KB EEPROM, in
an LQFP64 package

m On-board ST-Link/V2 with selection mode
switch to use the kit as a standalone
ST-Link/V2 (with SWD connector for
programming and debugging)

m Board power supply: through USB bus or from
an external 3.3 or 5 V supply voltage
m External application power supply: 3V and 5V
m Ipp current measurement
m LCD
— DIP28 package
— 24 segments, 4 commons
m Four LEDs:
— LD1 (red/green) for USB communication
— LD2 (red) for 3.3 V power on
— Two user LEDs, LD3 (green) and LD4
(blue)
m Two pushbuttons (user and reset)
One linear touch sensor or four touchkeys

m Extension header for LQFP&4 1/Os for quick

connection to prototyping board and easy
probing
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o La placa de desarrollo tiene las siguientes

STM32L-DISCOVERY

funcionalidades:

Microcontrolador STM32L.152RB

Interfaz de depuracion ST-LINK/V2 incluido
(conectado al ordenador a través de Mini-

USB)

Una pantalla LCD de 24 segmentos y 4
comunes

4 LEDs

o 2 de ellos programables por el usuario
(LED_VERDE, LED AZUL)

Un sensor tactil lineal, con posibilidad de ser
utilizado como 4 teclas individuales

Boton programable por el usuario (USER)

2 Puertos de expansion a placa adicional (P1
y P2)
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LDA
————————————— - -——-—————————
COM - l —— l o !
CNz — : _ LDz
SWD connector 025 . —||||| ! E lﬁ Im L PWR
| |%@- 2 |
I [MTCES !
STLINK/V2 : = ”’&'; = ﬁ : CN3 ST-LINK/DISCOVERY
| _E Eﬂ'ﬁ: . selector
[ = |
2V power - : _ I @ 5 " i 5V power
| .
, . tnm32t- drsmwe ————— - supply input/output
supply input/output Bl pe 06 s e .fs 500006660 [Nt PR INpUYOLT
T |® T T T ‘m_ . _I M
LcD — veo |@ IMB"""" Hibe  =EEfe | (efw IDD module
24 segments razl@| | b ) ° |III”III| |=| | |@lest—
— pera| @ It:u ([T ) L U L B L @l cne
SB1/2 T |eas|@| | =SEi=k X " | |@poer
IDD measurement ™ %‘b mee .:ﬂ. secce . e : o _ SB3 (BOOTO)
o on| . Idd Measure I® pd -
JP1 - —pahD p1 ml
Ipp Measurement :‘:T= @L ﬁ@ 5“4" : :::
rc1 | @ nzs n:? @2
Pz | @ e com® i MBI63 B |@|rci)
:: : é = -.'.an : (=81
= = . P10
STM32L152RT6 e @ = = v |@|ens
e = = DD W2 JP2 (3V/VBAT selector)
P3| ([T @ vaar B a3 (optional not mounted)
pad | @ @@Eﬁ] ggg oo :pm
SB4 Pas @ 0% - - Pa1)
B1-USER (=@ | B3 w ®|peg
Pllﬂl. SB‘I ‘ - d . PAg 585
< [ o\ TR - B2-RESET
P13/ ) T m L] | | @ B2
B1 FEIS Ej Ll
user button PEL : pgjg -j- [ | G || 86 (@ pes reset button
[ USER  suoe  RESET |, | :
GHD _& 51 GHD
LD3 —_— | = - T LD4
(green LED) | (blue LED)

Linear touch sensor ——

R

ftouchkeys

MS1904901
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D. DE BLOQUES Y LAYOUT

E‘éng' Alimentacion a través del USB

PUERTO P1: Embedded SRR
ST-LINKNZ
04 - PC13 o7 F;B7
15 — PAO = A ez
AT = TIM4_CH2
TIM2_CH1 _ETR Do R
19 — PA4 STM32L152RBTE 08 — PB6
RS I2C1_SCL
DAC_OUTl TIM4_CH1
20 Pt _ % E USART1 TX
SPI1_SCK E T el
DTN TIM3_ETR
- Green LED BZ 13 -PC12
TIM2_CH1 ETR - B
ue LED B1 USBDP
LD4 LUSER
PB6 PAO SPI1_MOSI
DD
Measurement [ | 20 - PAll
| USBDM
Llneri[r touch sensor SPI1 MISO
fouchkeys —

LCD (24 Segments, 4 Commons) a




o Display LCD de 6
caracteres con 2
formatos de
visualizacion
seleccionables:

e caracteres de 8 o

e caracteres de 14
segmentos

o Escala de barras en

la parte derecha.

BAR3

BAR2

BAR1

BARO
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o Durante el curso, se va a permitir el préstamo

personal de:

o La Placa de Desarrollo STM32L-Discovery

o El préstamo se hace con la condicién de que el
material se devuelva antes del examen en perfecto

estado

e De no ser asi, el alumno no sera evaluado en la

asignatura

o Para obtener el material:

e Imprimir, rellenar y firmar TRES copias del

9T0Z/T0/8T

om/stm32l-discoverv

on

000000 LOGGLG

formulario de préstamo del material. El formulario se
encuentra en Aula Global.

Entregar al coordinador de la asignatura el
formulario, para que lo firme y se quede con una copia. §

o Acercarse al despacho 1.1.1.04 0 1.1.1.03 para entregar &

= £5-38 38 -5 £ 3% Sy % I C BT EEESCERESD . L L=
POOO00O000000000000000000000E .= " a

la autorizacion firmada por el profesor, y recoger el

material.

o El material se devolvera en los mismos despachos,
entregandolo con el formulario de devolucion
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ENTORNO DE TRABAJO: KEIL
¢ UVISION 5

lopesaooidoldipy us sopeseg sajelbiq sewsalsiS  9T0Z/T0/ST




() CONCEPTOS FUNDAMENTALES

o El entorno de desarrolla se basa en el concepto de
proyecto, en el que se incluyen los ficheros (.sy .c) y
bibliotecas a compilar, para obtener el programa definitivo

o El programa se puede descargar directamente en la placa
de desarrollo a través de la opcién de Debug.

o La depuracién se puede hacer paso a paso, consultar
variables, registros, etc.

o Para simplificar el uso del sistema, especialmente en las
primeras practicas, se ha creado una biblioteca
(Biblioteca_SDM.lib) que facilita:

e La configuracion del reloj del sistema (SYSCLOCK) y sus
derivados.
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e La inicializacién del LCD y sus pines.
e El uso del LCD.
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() INSTALACION DE KEIL UVISION 5




INSTALACION

o El programa de instalacion se puede descargar:
e Directamente de la pagina de Keil (https://www.keil.com/arm/demo/eval/arm.htm)
rellenando el formulario y descargando en MDK

e Desde Aula Global , donde se encuentra el programa comprimido en 4 ficheros .rar, que
una vez descomprimidos, generan un fichero .exe que es el programa de instalacion.

o Ejecutando el mdk522.exe (o equivalente, ya que los nimeros pueden cambiar, al
cambiar la version) se arranca el instalador del uVision :
o Es preferible instalar el programa con la placa ya conectada, para que asi se instale el
driver de la placa
o Sino se hace asi, se puede instalar posteriormente el driver
e De a todas las pantallas sobre Next, introduciendo la informacion solicitada
o Si1no sabe que poner en alguna opcidon, déjela en su valor por defecto.

» Al finalizar la instalacién del uVision, se solicitara la instalacién de los drivers tipo
ULINK, ST-Link, etc.

o Aceptar todo el proceso

o En algunos ordenadores o cuando se haya instalado el pVision sin tener la placa
conectada, hay que instalar a mano el driver. Para ello:

e Vaya a la pagina http://www.st.com/internet/evalboard/product/251168.jsp y pulse en la
pestana “Design Support”.

* Seleccione para descargar el “ST-LINK/V2 USB driver for Windows 7, Vista and XP”

¢ Descarguelo (también se puede hacer esta escarga desde Aula Global), descomprimalo y
ejecutelo aceptando todas las opciones (incluso las preguntas de seguridad que impone el
Windows)

» Sisigue dando problemas, desenchufe el cable USB, espere unos segundos, y vuelva a
enchufarlo.

o Pruebe en distintos puertos USB

o Sitenia una instalacién anterior que no funcionaba, tendra que ir, con la placa conectada, al
Administrador de Dispositivos, y borrar el controlador que da fallos (el que salga con un simbolo de

exclamacién).
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https://www.keil.com/arm/demo/eval/arm.htm
http://www.st.com/internet/evalboard/product/251168.jsp

INSTALACION DE KEIL UVISION 5

o Ejecute el programa mdk522.exe (o la version actual
existente)

Setup PMDK-ARM Y517 >

Welcome to Keil MDK-ARM AR M KE “_

Releaze 1072015 o —
licrocontroller Tools

Thiz SETUP program installz:
MDE-ARM Y517

Thiz SETUP program may be uzed to update a previous product ingtallation.
Haowever, pou should make a backup copy before proceeding.

It iz recommended that you exit all Windows programs before continuing with SETUP.

Fallow the instructions to complete the product installation,

Mest 3>

9T0Z/T0/8T
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INSTALACION DE KEIL UVISION 5

o Acepte las condiciones de la licencia

Setup PMDK-ARM Y517 >

License Agreement AR M K E [ I_

Pleaze read the following license agreement carefully.

9T0Z/T0/8T

Microcontroller Tools

To continue with SETUP, vou must accept the terms of the License Agreement. To accept the
agreement, click the check box below.

EMD USER LICEMCE AGREEMEMNT FOR MDI-ARNM A

THIS EMD USER LICEMCE AGREEMEMNT ("LICEMCE" IS A LEGAL AGREEMENT
BETWEEM YOU (EITHER A SINGLE INDIVIDUAL, OR SINGLE LEGAL ENTITY) AND
ARM LIMITED {"ARM") FOR THE USE OF THE SOFTWARE ACCOMPANYING THIS
LICEMCE. ARM 15 OMLY WILLING TO LICEMSE THE SOFTWARE TO YOU OM
COMDITION THAT wyoul ACCEPT ALL OF THE TERMS IM THIS LICEMCE. BY
CLICKIMNG " AGREE" OR BY INSTALLING OR OTHERWISE USING OR COPYING

v | agree to all the terms of the preceding License Aareement

<< Back | Mest 3> Cancel
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INSTALACION DE KEIL UVISION 5

o Seleccione el lugar para la instalacion, o acepte
ubicacion por defecto

Setup PMDK-ARM Y517

Folder Selection AR M K E |L

Select the folder where SETUR will inztall files. o —
licrocontroller Tools

Fresz Mest' to install MDK-AFM to these folders. Press ‘Browse' to select different folders for inzstallation.
Destination Folders

Core: |E:'\Keil_v5 Browse .. |

Pack: |C:\Keil_vBhaRMAPACK Browse ..

<< Back Cancel

la

Pt
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o Introduzca sus datos

Setup PMDK-ARM Y517

Customer Information

Fleaze enter paur infarmatian.

INSTALACION DE KEIL UVISION 5

ARMKEIL

Microcontroller Tools

Pt

Pleaze enter your name, the name of the company far whomn you work, and your E-mail address.

First Mame:

Last Name:

Company Mame:

E-mnail:

— el MDE-45M Setup

<< Back I Mest 5 I

Cancel

9T0Z/T0/8T
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INSTALACION DE KEIL UVISION 5

o Espere a que se instale la aplicacion

Setup PMDK-ARM Y517

Setup Status ARMKEIL

Microcontroller Tools

Pt

MDE-ARM Setup iz performing the regquested operations.

[hztall Files ..

Inztalling cpp_pen.|.

— el MDE-45M Setup

<< Back I Mest 5 I Cancel

9T0Z/T0/8T
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INSTALACION DE KEIL UVISION 5

o Una vez finalizada la instalacién le puede solicitar ver las
Release Notes y usar (o no) la configuracién anterior (s1
tenia ya una version anterior instalada.

Setup MOK-ARM V5T et

Keil MDK-ARM Setup completed ARM KE [ I_

MOK-AFM w517 Microcontroller Tools
icrocontroller oo

MO k-8R Core Setup haz performed all requested operations succezsfully.

[ Show Release Motes

[ Retain current phizion configuration.

Finizh

9T0Z/T0/8T
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INSTALACION DE KEIL UVISION 5

o Una vez instalado el uVision, se le solicitara que instale los
paquetes necesarios

=

.. . ®
» uVision es una plataforma de desarrollo que contempla multitud de 3
-

. . N

procesadores, por lo que instalar todo puede ser excesivo. 2
(o))

File Packs Window Help 92)

I o | Device: ’ %
ﬂ Devices Boards ﬂ ﬂ Packs Examples ﬂ 3

. — QD

Search: - X ‘ | Pack Action Description (7]
Device & | S Pack Installer e 9

=1 % All Devices 10 %

+- W ARM 10 Ao, Welcome to the Keil Pack Installer @ CMSIS (Cortex Microe Q

L Pack_InstaIIer isa u_tility for rmanaging Software Packs on the local computer and @ Keil ARM Cempiler e 8

| provides the Following windows: Iate | Keil MDK-ARM Profer o
Devices  List supported devices, Select a device to show related Packs and examples., 8

QD

| Boards  : List supported boards, Select a board ko show related Packs and examples, %
Packs : List and manage Software Packs. Install a Pack for access within uvision, g

Examples : List example projects. Copy projects and launch piision For kesting examples. 2

Pack Installer connects to wiwwe kel comdpack to obtain the published Software Packs, §

Toinstall a local Software Pack use File - Import... from the menu, (@]

©

4 -
a [v Show this dialog at startup Help j 8
]

Cutput o x (%))
JRefresh Pack descriptions 8_
Check far updates (@]
=

Action (1 left): Update Pack descriptions, download http://www.keil.com/pack/Keil. Kinetis_KWPR1516_DFP.pdsc ‘4% OMLINE




INSTALACION DE KEIL UVISION 5

o Localice (en la pestana Devices) la familia de

STMicroelectronics

B8 Pack Installer - CAKeil WSUARMYPACK - ¥
Eile  Packs Window Help
I e | Device:
ﬂ_ Devices r- Boards ] ﬁ g Packs r Examples ] ﬂ
Search: - X Pack Action Description
Device /| Summary E----Device Specific 0 Packs ||
£ @ Silicon Labs 357 Devices | | = Generic 12 Packs
LW SOMIX 40 Devices [#-ARM::CMSIS & Up to date || CMSIS (Cortex Micr
@ m [+--ARM: CMSIS-Driver_Va... g% Install | CMSIS-Driver Valida
H-T% STM322FD Series 66 Devices +-ARM:mbedTLS g% Install I ARMmbed Cryptog
#-94% STM322F1 Series 195 Devices #-Keil:ARM_Compiler & Up to date | Keil ARM Compiler
H-% STM322F2 Series |46 Devices #-Keil:Jansson ¥ Install || Jansson is a C librar
B9 STM32F3 Series 70 Devices - Keil:MDK-Middleware |4 Update | Keil MDK-ARM Prof
#-%% STM32F4 Series 153 Devices F-twlPalwlP & Install || wiP is a light-weigk
H-9E STM32FT Series |20 Devices #-MicriumzRTOS ¥ Install || Micrium software ¢
B9 STM32L0 Series 90 Devices #-Oryx-Embedded:Midd...| €3 Install || Middleware Packag
H-4E STM22L1 Series 60 Devices F-wolfS5L: CyaSsL & _Install || Light weight S5L/TL
59 STM322L4 Series |46 Devices #-YOGITECH:fRSTL_AR... |4 Install || YOGITECH fRSTL R
H- STM22W1 Series 5 Devices [#-YOGITECH:fRSTL_ST... |4 Install || YOGITECH fRSTL R
- @ Texas Instruments 341 Devices . >
El‘ [ R P W ﬁj [ ‘I I _’I_I
Output a x
Refresh Pack descriptions
Check for updates
Refresh Pack descriptions
Update available for Keil::MDE-Middleware (installed: 6.5.0, available: 7.0.0]
Ready [ [onune
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o Navegue por el arbol de dispositivos hasta encontrar el STM32L1

Series

o Seleccione esa opcion y pulse “Install” o “Update” en cada uno de los

INSTALACION DE KEIL UVISION 5

botones que aparecen en la ventana de la derecha

o Esto hara que se conecte a internet para bajarse las Gltimas versiones

@ Pack Installer - CKeil_wTWARMYPACK - X
Eile  Packs Window Help
3’ Device: STMicroelectronics - STM32L1 Series
ﬂ Devices Boards ﬂ ﬂ Packs Examples ﬂ
Search: - X Pack Action Description
Device /| Summary —|-Device Specific 2 Packs =
< "B STM22F2 Series 46 Devices j +-Keil:STM32L 1o _DFP Inztall S5TMicroelectronics
+ "B STM22F2 Series 70 Devices +-Keil:STM3ZNUCLED_B... Install S5TMicroelectronics
-5 STM32F4 Series 153 Devices - Generic 12 Packs
+-4% STM3I2F7 Series 29 Devices +- ARMCMSIS 2 Up to date || CMSIS (Cortex Micr
+-4% STM322L0 Series 30 Devices +- ARMu CMSIS-Diriver_Va... @ Install CMSIS-Driver Valida
% &0 Devices +-ARM:mbedTLS @ Install ARMmbed Cryptog
+-2 STM22L100 4 Devices +--Keil: ARM_Compiler Q Up to date | Keil ARM Compiler
%2 STM22L151 32 Devices +--Keil:lansson Install Jansson is a C librar
5 V‘}LZ STM22L 157300 8 Devices +-Keil:MDE-Middleware | €% Update Keil MDE-ARM Prof
+-4 sTM3I2L152 71 Devices +- il Pzl P @ Install IwiP is a light-weigt__ |
H- STM22L152:A 3 Devices +--Micrium:RTOS @ Install Micrium software ¢
%2 STM22L162 6 Devices +|--Oryx-Embedded:Midd... @ Install Middleware Packag
%% STM322L4 Series 46 Devices +|-wolf55LiCyaSsL @ Install Light weight 55L/TL
w72 STM32W1 Series 5 Devices i +-YOGITECH:fRSTL_AR... Install YOGITECH fRSTL Fu »
(il Tornmem b e cimm mimde A1 M vimmm ﬂ b | | L,J
QOutput o x
Refresh Pack descriptions
Check for updates
Refresh Pack descriptions
Update available for Keil::MDE-Middleware (installed: 6.5.0, available: 7.0.0)
ONLINE

Ready
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INSTALACION DE KEIL UVISION 5

o Durante la instalacion de los paquetes, le pedira que
acepte algunas licencias de uso. z
Pack Unzip: Keil Jansson 1,00 >
License Agreement ARM KE“_
Flzaze read the following license agreement carefully. s
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licrocontroller Tools

To continue with SETUP, vou must accept the terms of the License Agreement. To accept the
agreement, click the check box below.

copies of the Software, and to permit perzans to whormn the Software iz s
furnizhed to do 20, subject to the fallowing conditions:

The above copyright notice and thiz permiszion notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE 15 PROVIDED “AS 15", WITHOUT WARRAMTY OF ANy KIND, EXPRESS

OR
[MPLIED, INCLUDIMNG BUT MOT LIMITED TO THE WARRAMTIES OF MERCHAMTABILITY, .,

CITeRIC™™ FOm A BADTICHIL AN R ARG RICRHRIEFlR e dr eI T Ik RIC PATRIT CLLALL

v | agree to all the terms of the preceding License Aareement

Mest > | Cancel |




INSTALACION DE KEIL UVISION 5

o Una vez instalados todos los paquetes, la apariencia debe ser
como la de la figura.

o En este momento puede cerrar el instalador de paquetes y ya
puede utilizar el uVision 5, como si fuese cualquier otro
programa de Windows.

9T0Z/T0/8T

%2
0
B8 Pack Installer - CKeil_wSWARMYPACK - X ol
File Packs ‘Window Help 3
,E'} Device: STMicroelectronics - 5TM32L1 5eries 8
ﬂ Devices Boards ﬁ ﬂ Packs Examples ﬂ 9
«Q
Search: X Pack Action Description ;f—)"
Deviee /| summary -1-Generic 12 Packs ﬂ D
T v‘ig STM32F3 Seriec 70 Devices ﬂ +--ARM: CM3EIS ! UE to date || CMS5IS (CDI’tE}( Micr (é
< vig STM22F4 Series 153 Devices +--ARM:: CMSIS-Driver_Va... Up to date | CMSIS-Driver Valida Q
4. STM32F7 Series 29 Devices +--ARM:mbedTLS ! Up to date || ARMmbed Cryptog g
%2 STM32L0 Series 90 Devices +-Keil: ARM_Compiler 2 Up to date | Keil ARM Compiler 8‘
SE vl STM22L1 Series 60 Devices +--Keil::Jansson Up to date |[Jansson is a C librar n
w42 STM3ZL10D A Devices +-Keil:MDK-Middleware | € Up to date | Keil MDK-ARM Prof g
% STM32L151 22 Devices b P lwiP i Up to date | lwlP is a light-weigt Z
#-42 STM32L15150h 8 Devices +-Micrium:RTOS i Up to date | Micrium software ¢ 2
-5 sTM32L152 21 Devices +--Oryx-Embedded:Midd... i Up to date | Middleware Packag _8
#-% STM32L1525ch 8 Devices +-wolfS5LiCyassl ! Up to date || Light weight S5L/TL 3
0% STM32L162 6 Devices +-YOGITECH:fRSTL_AR... Up to date | YOGITECH fRSTL Fu 8
T v‘ig STM3ZL4A Seriec AF Devices + YOG'TECH:IfRSTL_ST... Up to date || YOGITECH fRSTL Fu g
+ 1 STM32W1 Series 5 Devices i o3
+-- % Texas Instruments 341 Devices f -
0 d Tarkila- O Mmssimmem ﬂ h | | L4
Output nx
Refresh Pack descriptions -~
Update available for Keil:MDK-Middleware (installed: £.5.0, available: 7.0.0)
Refresh Pack descriptions
Check for updates
Refresh Pack descriptions W

Ready QOMLINE




PASOS PARA LA CREACION DE UN
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lopesaooidoldipy us sopeseg sajelbiq sewsalsiS  9T0Z/T0/ST




PASOS EN LA CREACION DE UN PROYECTO

o Al arrancar el Keil uVision 5, asegurarse que no hay
ningun Proyecto abierto, utilizando la opcién
Project» Close Project

KA pwision — *
File Edit View Project Flash Debug Peripherals Tools SVWCS Window Help

NEH@ @9 c|e[Ponh|FFEiRe LELILTE)
S N R

a3

=] Project| ﬁBooks | {} Func...l [].,Temp...

Build Qutput
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PASOS EN LA CREACION DE UN PROYECTO

o Para crear un proyecto utilizar la opcién Project» New

L] L] L] H
uVision Project &
~~
o
H
KA wision - > B
File Edit View  Project @ Flash Debug Peripherals Tools SVCS  Window Help S
B ‘j| Mew uVision Project... ) | ) | K
Mew Multi-Project Workspace... I
Open Project... g)
Project ﬂ
Close Project D
Export » Q
(7))
Manage » o
Select Device for Target ... %
Remaove I[tem %
. Options... Alt=F7 n
vy)
Clean Targets 8
Build Target F7 8_
Rebuild all target files 8
Batch Build... D
>
L Translate... Ctrl=F7 Z
Iz | Project] Eook
(el Project €5 Stop build =
Build Output L | S
1 D:\Datos\Docencia\SDM\2015_16\Ejemplos\pv5\prusba.uvprojx S
2 D\Datos\Docencia\SDWM\2015_16\Ejemplos\04_1_GPIOWPrueba_GPIO.uvprojx 8
(@)
]
(%))
Q
o
o
-

Create a new pVision project




PASOS EN LA CREACION DE UN PROYECTO

o Después de seleccionar la carpeta donde va a ubicar todos los
ficheros del proyecto, de un nombre significativo al proyecto

=
* Se recomienda que para cada programa cree un proyecto distinto, y =
. N,
que para cada proyecto, cree una carpeta distinta 2
(o3}
[
File Edit Wiew Project Flash Debug Peripherals Tools 5VCS5  Window Help g’)
; — . 0
5@ | | | = E | o L # | @ | o
KA Create Mew Project x g
Project %
<« v < Ejercicios_SDBM » Ejercicio 3-1 v Buscar en Ejercicio 3-1 A W)
Q
Organizar = Nueva carpeta == - g"_)"
Archivos de programa (£ ™ Maombre a Fecha de modifica.. T 8
Canfig.hsi oy}
MNingdn elernento coincide con el criterio de basqueda, Q
DELL 0
j8b)
7 Docurnents and Settings %
Drivers »
®
Ejercicios_SDEM =
Ejercicia 3-1 ;
(@]
Intel v £ 3 8
- — °
il project € Nombre: | &3 _1| w o
(@]
Build Output Tipo: | Project Files (*.uvproj; *.uvprojx) w L x| 8
jab)
o
“ Ocultar carpetas Cancelar Q

i 9:21
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PASOS EN LA CREACION DE UN PROYECTO

o En la siguiente pantalla tiene que seleccionar el
microcontrolador con el que va a trabajar

=
(09]
. . . S
» Seleccione la carpeta STMicroelectronics 2
N
. o o
» Seleccione el microcontrolador STM32L152RB >
i i
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Helgd File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
=] Select Device for Target ‘Target 7', = Select Device for Target 'Target 1., |
Device l Device l
Project Project
|Software Facks j |Software Facks ﬂ
YWendor  <unbnowe Yendor  5TMicroelectionic:
Device:  <unknowr: Device:  STM3ZL152RE
Toolzet:  <unknowurs Toolzet:  ARM
Search: | Search: |
Description: Description:
+-- % ARM - g4 sTM32L152CB ﬂ STMicroelectronics' STM32L1 seres uzes ulra-low-leakage process
” technology with a autonomaouz dynamic voltage scaling and 5 low-
=¥ @ sTm3aLisacc power modes affering unprecedented platform fesibility to fit any
471 STM32FD Series € sTMI2L1520C application.
» . Typical applications include Medical and handheld equipment,
T STM32F1 Series €3 sTm32L1520D Application control and user interface, PC peripherals, gaming. GFS
4“5 STM3ZF2 Series &3 STM322L1520QF J and zport equipment, &larm spstemns, wired and wireless senzors, Yideo
[lals , Lol Ler
| 043 STM32F3 Series | @ sTm32L152RE rieream. Sy meeing
ﬂ Project @E s vf:; STM32FS Series ﬂ Project @E ﬂ STM32L152R8
Build Qutput +-71% STM32FT Series Build Qutput ol STM32L152RE 1 B3
#1715 STM32L0 Series g1 STM32L152RC
% STM32L1 Series A ol | v~

o]

Canhicel

o]

Canhicel

Help



PASOS EN LA CREACION DE UN PROYECTO

o En la siguiente pantalla es necesario seleccionar los elementos
relacionados con el microcontrolador (y la placa de desarrollo)
que se han de integrar al proyecto. Para ello seleccione:

o Device P Startup
« CMSIS » CORE
(W

9T0Z/T0/8T

0
File E¢™" ™" e - - 9'_
kdanage Run-Time Environment hd § )
5 | @ 3
Software Component Sel.  Variant Version Description 8
Frojeet + @ Board Support Koala EVM 1.0.0 Koala EVM BSP = g
= @ CMSIS Cortex Microcontroller Soft Q.
¥ CORE [+ 43.0 CMSIS-CORE for Cortex-IM g
¥ DSp I 1.4.6 CMSIS-DSP Library for Cort 8
o€ RTOS (API) 1.0 CMSIS-RTOS AP for Cortex: w
| @ CMSIS Driver Unified Device Drivers com) 8
+| @ CMSIS Driver Validation API 1.0.0 Run API test for enabled dri 8_
o & Compiler ARM Compiler Software Ext @)
w4 Data Exchange Software Components for T g
- 4 Device Startup, System Setup >
¥ Startup [¥ 1.0.0 System Startup for STMicro ;
3 @ File System MDK-Pro 6.6.0 File Access on varicus stora 2
3 @ Functicnal Safety Yogitech fRSTL Safety Softw -8
L 3 @ Graphics MDK-Pro 5.30.0 User Interface on graphical 8
=] Proje: « A L‘J 8
Build Oul — — i | g
Validation Qutput Description . o
=
Resolve Select Packs Details Help




PASOS EN LA CREACION DE UN PROYECTO

o Una vez finalizada toda esta fase, aparece el proyecto creado con
algunos elementos integrados (CMSIS y Device) y una carpeta
denominada SourceGroupl en la que introduciremos los archivos
fuentes del proyecto

» Esto se comentara mas adelante, porque todavia faltan pasos

9T0Z/T0/8T

CihvEjercicios_SDBMNEjercicio 3-1hej3_T.uvprojx - pMision - bt
File Edit View Project Flash Debug Peripherals Tools S5VC5 Window Help

nﬁﬁumﬁmww S|P RR R EE kS HE e @l o
= MR AE e Y

Eﬁg Project: ej3_1
B- w
----- Ei Source Group 1
& omsis
‘ Device

& project € Books | {1 Func...| [, Temp...

Build Output
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PASOS EN LA CREACION DE UN PROYECTO

o Hay que configurar el entorno de desarrollo, y en concreto
el Depurador y la herramienta para cargar la aplicacion

o Pulse en el boton derecho en Target y selecciones Options
for Target ...

9T0Z/T0/8T

KA coFjercicios_SDBMYEjercicio 3-14ej3_1.uvprajx - phision - x wn
File Edit View Project Flash Debug Peripherals Tools 5SVCS  Window  Help ﬂ
(¢]
E A = = I SRR ] g
EAN B9 | Terget1 VKB R e P %
Project a -
roje B =)
=1 Project: 3_1 g
=P T?-n:d-‘l o)
dﬁﬁ Options for Target ‘Target 1'... Alt=F7 (7]
& o
* Add Group... o))
o w0
é Manage Project [tems... g_
¥ Rebuild all target files 8
%] Build Target Fr o
>
v | Show Include File Dependencies Z
=5
=
o
i
l _ o
=] Project € Books | {} Func... [, Temp 8
(%))
Build Qutput B | Q
o
o
-

Configure target options ULIME2A

) \ 9:30
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PASOS EN LA CREACION DE UN PROYECTO

o Seleccione la pestana Debug y seleccione la opcion de utilizar un
depurador (la columna de la derecha) y dentro de las opciones de
depuradores, seleccione el ST-Link Debugger

o Fijese en las casillas que estan activadas en la figura, puesto que es la
configuracién recomendada.

&

File Edit Wiew Project Flash Debug Peripherals Tools SVCS  Window Help
5 [& A options for Target ‘Target 1 ¥ @ﬁ| @| ®

@ AT Devicel Target] Dutput] Listing] Jser I C£E++] Azm ] Linker Debug ] LItiIitiesl

I " Use Simulatar  with restrictions Settings CNIEC (ST ink Debugger Seftings | v =
= Project: [ |y Speed to Real Time "~
—| % Tarc
LS ¥ Load Application at Startup ¥ Buri to mainl) ¥ Load Application at Startup [¥ Run to mainl)
- Initialization File: Imitialization File:
Restore Debug Session Settings Restore Debug Session Settings
% [¥ Breakpoints W Toolbox W Breakpoints W Toolbox
=] @ [¥ wfatch windows & Performance Analyzer W wiatch Windows
¥ Memary Display ¥ System Viewer ¥ Memary Display W System Yiewer
+ y
1 v
Elproject{€¥E  CRUDLL: Parameter: Ciriver DLL: Parameter: ¥
Build Output |SARMEM3DLL | -REMAP MPU |SARMEM3DLL | -MPU P x|
Dialog DLL: Parameter; Dialog DLL: Pararneter;
|DCM.DLL | PCM3 |TCM.DLL | PCM3
ak. | | Cancel | | Defaults |
ULINE2/1

@ = B =

9T0Z/T0/8T

0
9]
=
D
3
Q
(2}
9
Q
=1
)
D
2}
oy}
o))
(9]
Q
Q.
@)
(9]
@
>
=
(@)
=
o
o
=
o
(@)
D
n
jab}
Q.
o
-




PASOS EN LA CREACION DE UN PROYECTO

Después de seleccionar el depurador (ST-Link Debugger), pulse el boton de Settings, para ver
la configuraciéon del mismo

Seleccione como puerto SW.

S1 tiene conectada la placa, entonces vera a la derecha los datos de la placa conectada (ver
figura). Si no, vera una pantalla como la de la figura de la transparencia siguiente.

En cualquier caso, fijese en las casillas seleccionadas y use esa configuracion

Cortex-bA Target Driver Setup >

Debug lTrau:e ] Flash Du:uwnlu:uad]

[Debug Adapter S Device
Urit: |ST-LINKA2 Dovics Mame
Serial Mumber: SwDl 0x2BADT477  ARM CoreSight Swi-DP

| 303030303030303030303031

Hiw Werzion: W2

M ax Clack: |1_BMH2

[ebug
Connect & Reset Options Cache Optionz

Connect: | Maormal | Feset: |.-’-'-.uh:u:|eteu:t ﬂ [v Cache Code

[+ Beset after Connect W Cache Memary

Download Options

v “Yerify Code Download
[v Diownload to Flazh

Aceptar | Cancelar
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PASOS EN LA CREACION DE UN PROYECTO

k2
File Edit Wiew Project Flash Debug Peripherals Tools SVCS  Window  Help
=" W
%ﬁ — Cortex-h Target Driver Setup
Project | Debug l Trace ] Flash Du:uwnlu:uad]
0-*1% Project: [Debug Adapter JTAG Device Chain
- 55 Targ I mit: | j rrar
o | Serial Number: D No ST-LINK detected
=4 ||
H Wersion: [ J
P ersion: {+ |
| {
g I Part: |JTAG - |
b aw Clock: |1.12MHz - | |
ik [Debug
Connect & Reszet Options Cache Options Download Optionz
Conmnect: |N|:urmal ﬂ Reset: |.-'1'-.ut|:u:|etect ﬂ [v Cache Code [v “Yerify Code D'ownload
Ll__. ¥ Feset after Comnect [v Cache Memary [+ Download to Flazh
i=] Project| €3 8 =
Build Qutput
Aceptar | Cancelar
- - R _—

X

¢ Qe

n A

ULINK2/1
12:10
18/01/2016
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PASOS EN LA CREACION DE UN PROYECTO

o Después de aceptar las opciones del depurador, seleccione
la pestana de Utilities y copie la configuraciéon que se
muestra en la pantalla

&2

File Edit View Project Flash Debug Peripherals Tools 5SVCS  Window  Help

= = B Options for Target Target 1' xor | @|

ksl B Device| Target| Output| Listing | User | C/Ce+ | Asm | Linker | Debug  Utiliies

Project Configure Flash Menu Command

=14 Project: . ) )
. * Usze Target Driver for Flazh Programming v Usze Debug Driver
gy Targ

-~ Use Debug Driver - W Update Target before Debugging

g Init File: . J Edit.

" Use External Tool for Flash Programming

Command:l J

Arguments; |

-

Configure Image File Processing [FCARMI:
i — Output File: Add Output File ta Group:
=] Project €3¢
| Source Group 1 j
Build Qutput B |
Image Files Foaot Folder: I Generate Listing

(] | Cancel | Defaults Help

ULIMEZ/
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PASOS EN LA CREACION DE UN PROYECTO

o Pulse en el botéon de Settings (dentro de Utilities) y verifique
que tiene un mapa de memoria instalado (por ejemplo el
expuesto en la figura)

o También se recomienda que se seleccione “Erase Full Chip”

9T0Z/T0/8T

k %)
File Edit WView Project Flash Debug Peripherals Tools 5SWVCS5  Window Help Q_
- ) (¢]

== AL, gkl 3

s | ) Q

) Cortex-M Target Driver Setup X n

e Flazh Download 9
1 lash Downloa «Q

oA Project: Debug] Trace =
=3 Targ Download Function————— Rab for Algorithm %

3 | popp ™ EraseluiChie # Progam wn

@ | _Fi (" Erase Sectors v Werify Start: |D:-:2DDDDDDD Size: |0x1000 w

" DonotErase |~ Reset and Run Q

+] <:> | ()]
Pragramming Algarithm g_

Description | Device Size Device Type Address Range 8

STMIZL1xx Med-denzity Flash 128k On-chip Flash (2000000H - D801FFFFH o)

S

=

O

=

o

©

L — Start: | Size: 8
k=] Project €3 8
Build Output Add | | o | 8
o

o

-

ak | Cancel | Help
0K | Cancel | Defaults | Help

ULIMEZ/
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PASOS EN LA CREACION DE UN PROYECTO

o Una vez aceptados los cambios en la configuracion del Target, el proyecto esta
listo para poder darle contenido, creando e importando nuevos ficheros fuente.

o Empezamos creando un fichero fuente, para lo que seleccionamos File » New... g
o Esto creara una sub-ventana en la parte gris de la derecha, para poder teclear el S
codigo S
(o]
ChEjercicios_SDBMNEjercicio 3-Thej3_luvprojs - phision - *
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
1 New cnhob | o | BB B R EE RS e
= omen ar-o PRI
= Save Ctrl+5
Save As..
il save Al

N
0
—
@D
3
QD
(2}
9
Q.
—
=R
D
2}
oY)
Q
n
j8b)
o
o]
2}
®
>
=
e}
=
o
°
=
o
(w)
D
n
Q
o
o
=

Device Database...

License Management...

Print Setup...
Print... Ctrl+P

el

Print Preview

1 D:\Dataos,.\pv5imain.c
2 D:\Datosh..\04_1_GPICAmain.c

Exit

Build Qutput

< >
Create an empty document LILINEZ/

B E




PASOS EN LA CREACION DE UN PROYECTO

o Una vez escrito el codigo (en el que no esta resaltada la

L] L] L] 1]
[EEN
sintaxis por no saber el entorno que tipo de fichero es), Z
° o » ° |:
hay que guardar el fichero con la opciéon File » Save S
)
K2 CaEjercicios_SDBREjercicio 3-Thej3_1 uvprajx - pWision - K wn
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help %
New... cr-n b | | | &= = | VR e Q| 3
= Open Ctrl+0 v d’:\l r & > & 8
Close -
[ save Ctrl+5 L] Textr- vx Q
cove A 15 LCD_Limpia); ~ o
16 LCD_PreparaBarras{OMN, OFF, ON, OFF3; D
@ save Al 17 LCD_Texta("DOS"y; n
18 esperal5000000%; o
Device Database... 10 LCD_Limpia(); 8
License Management... 20 LCD_PreparaBarras{OMN, ON, OFF, COFF}; Q
21 LCD_Texta("TRES"); %
Print Setup... 22 espera(5000000}; wn
& Frint.. Ctrl=P 23 LCD_Limpia(); @
_ _ 24 LCD_PreparaBarras{OFF, OFF, ON, OMN}; >
Print Preview 2E LCD_Textof"MAAAMBO"Y; <
) o 26 espera(50000007%; o
1 DDatosh...\pvSimain.c o7 1 =
2 D:\Datos\,...\04_1_GPIO\main.c 28 T '8
| 29 v o
Exit < ? @
Build Output L < | $
o
Q

Save the active document ULIMEZ/




PASOS EN LA CREACION DE UN PROYECTO

o Pongale un nombre con la extensiéon adecuada al formato (por ejemplo, si es un fichero en C,
pongale un nombre acabado con .c; si es un fichero “header” de C, pongale un nombre acabado

con .h

=

., , . . o Q

o Al almacenarlo con un nombre y extensién, ya sera posible que el entorno resalte la sintaxis S

con colores. N

o

o El nombre del fichero puede ser cualquiera, pero se aconseja que sea un nombre 5
representativo

e %

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help ﬂ

A D

EEd| s o@dl9 o | m = iE | & vVEel Q) 3

[ B R Save s * %]

Project - X 9

T « Ejercicios_S.. » Ejercicio 3-1 » v O Buscar en Ejercicio 3-1 yel Q.

=¥ Proje 2 E.;

Hag T Organizar « Mueva carpeta == - 0 D

~ (7]

5 Archivos de programa ™ Mormbre Fecha de rodifica.. T w

: . )

& Archivos de programa (xt Listings 18/01/2016 3:30 c @

Canfig.hdzi Ohjects 18012016 9:30 o %

DELL RTE 180172016 230 ( (7]

& Documents and Settings L] ej3_Tuvapt 18/01/2016 922 & g

Drivers KA &3 Tuvprojx 1801,/2076 222 H =

Ejercicios_SDBM g

Ejercicio 3-1 v o< > 'Q

L w7 o

=] Project| € Nombre: | principal.¢f w z 8

Build Output Tipo: | All Files (*7) v r 2 8

. Al Q.

o

4 Ocultar carpetas Cancelar

ULlNKZJ




PASOS EN LA CREACION DE UN PROYECTO

o Sin embargo, todavia no esta ese fichero en el proyecto, por lo que
habra que decirle al proyecto la necesidad de incorporarlo al mismo.

o Para ello pulse el botéon derecho en SourceGroupl y seleccione Add
Existing Files to Group “SourceGroupl” ...

9T0Z/T0/8T

KA CrEjercicios_SDEMAE]ercicio 3-T4ej3_T.uvprojx - pWision - >
File Edit View Project Flash Debug Peripherals Tools SVCS  Window  Help
BHd@ B9 @ P | &= & | VB2 e q
(5 B8 @ (] 9| Target EEE -
Project oA [] principal.c o &
=% Project: gj3_1 1/%+% Ejemplo de uso del LCD #%/
— g Target 2

3 Hinclude "Biblioteca 3DM.h"

[ Source Groun 1
Alt=F7 FPH-R"

& cmsis 4% Options for Group ‘Source Group 1°...

+ @ Device

Add New Iltem to Group ‘Source Group 1°...
Add Existing Files to Group 'Source Group 1°..

Remove Group ‘Source Group 1° and its Files

#4 Rebuild all target files i ;
m Build Target F7 [Earras (0N, ON, CN, ONj:
Mo ;
t Manage Project [tems... ooo) :
l | ; v
EIiject @3::_.; v | Show Include File Dependencies >
Build Output R x|

lopesas0.1doidi\ us sopeseg sajenbiq sewalsis

Add Existing Files to current Project Group ULIMNEZ/1




o Se puede ver el fichero integrado ahora en el proyecto, pero sin embargo
se notifican errores. Eso es porque faltan todavia ficheros por integrar

0 Se aconseja que copile en la misma carpeta donde esta el proyecto los
ficheros .h que se vayan a importar, asi como cualquier otro fichero que se

PASOS EN LA CREACION DE UN PROYECTO

haya de integrar en el proyecto (archivos .c, archivos .lib, etc.)

KA cojercicios_SDBEMYEjercicio 3-1hej3_1.uvprajx - phision - X
File Edit WView Project Flash Debug Peripherals Tools 5SWVCS5  Window Help
Edd| B9 || P | &= & | & R ale
£ EEe P | Target1 VK| AR e Y@
Project L = | ] principal.c v
=71 Project: gj3_1 1/%% Ejemplo de uso del LCD *%/ ~
—l-ga7 Target 1 2
=-|.% Source Group 1 x 3 !ﬁinclude NBibliotecs SDHM.L"
L 4 finclude "Utiles IDM. L™
2l principal.c 5 -
@ CMSIS & int mwain(void){
7% Device 7 Init SDM{):
g Init LCD();:
9
10 while (1) {
11 LCD_Limpiaf);
12 LCD_ PreparaBarras (ON, CMN, ON, ON):
13 LCD_ Texto ("UNOT™) ;
14 ezpera (S000000) ;
| 15 LCD Liwpial); ¥l
EIProject@E:: s | {} Func... [, Temp < o
Build Output x|
fatal error: ‘Biblioteca_SDM.h’ file not found ULIMEZ/1
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PASOS EN LA CREACION DE UN PROYECTO

o De la misma forma que hizo con el fichero .c inicial, inserte en el proyecto (dentro de SourceGroupl) el resto
de ficheros compilables y linkables necesarios
e Ficheros .c y ficheros .lib
e NO inserte los ficheros .h, puesto que éstos se integraran solos al compilar el proyecto.

o En el ejemplo, el proyecto queda como en la figura, habiendo integrado la biblioteca suministrada

(Biblioteca_SDM.lib) y una biblioteca adicional creada por los profesores (que no se distribuye) denominada
Utiles_SDM.c (en un futuro se le aconsejara a los alumnos que creen su propia biblioteca de utilidades)

9T0Z/T0/8T

KA coFjercicios_SDBMYEjercicio 3-14ej3_1.uvprajx - phision - x
File Edit View Project Flash Debug Peripherals Tools 5SWVCS  Window Help
@ | == | @ | &= | & VEe Qe
¥ | Torget R B R e O
Project L = | ] principal.c v R
-1 Project: g3_1 1/++ Ejemplo de uso del LCD  #%/ ~
g Target1 2

3 #include "Biblioteca SDM.h"

-5 Source Group 1
4 #include "Uciles SDM.h"
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] principal.c 5
L1 Utiles_SDM.c £ int mwain{void){
1 Biblioteca_SDM.lib 7 Init SDM():
& cmsis 8 Init_LCD(:
. 9
=¥ Device 10 while (1]
] startup_stm32To_md.s ( 11 LCD Limpia():
_] systern_stm321Txc 12 LCD _PreparaBarras (o, oM, ON, ON):
1 13 LCD_Texto([UNOT) :
14 espera (S000000) ;
k1 | | 15 LCD_Limpial) ; v
=] Project| € 5ooks | {} Func...| (1, Temp < o
Build Qutput B |
cowpiling Uciles 3DM.c... ~
compiling system stm3Zllxx.c...
linking...
Program Size: Code=6444 RO-dats=345 RU-data=3Z ZI-data=1632
"4 Objectshed 1.axf" - 0 Erroris), 0O Warningis).
Euild Time Elapsed: oo:00:01 =

For Help, press F1 ULIME2A




PASOS EN LA CREACION DE UN PROYECTO

o Kl proyecto ya esta listo para compilar

L] L] L] L] H
o Seleccione Project » Rebuild all target files 2
(@)
H
~
N
o
H
(@)]
K2 CiEjercicios_SDBM\Ejercicio 3-1vej3_1.uvprojx - piisian - >
File Edit View Project Flash Debug Peripherals Tools  SVCS  Window  Help
Mew uVision Project... o _:—,& ;ﬁ| @| Y
Mew Multi-Project Workspace...
Open Project...
Project - X
Cl Project
= “I% Project: g3_ ose Tl ~
=45 Target 1 Export »
=5 Sour Manage 3

0
9]
=
D
3
Q
(2}
9
Q
=1
)
D
2}
oy}
o))
(9]
Q
Q.
@)
(9]
@
>
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=
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o
=
o
(@)
D
n
jab}
Q.
o
-

Select Device for Target ‘Target 1° ...
Remove File 'principal.c’

« Options for File ‘principal.c’... Alt=F7

Clean Targets

Build Target F7
M, CH)
Rebuild all target files
Batch Build...
Translate C:\Ejercicios_SDEM\Ejercicio 3-1%principal.c Ctrl=F7 7
>
Stop build
Build Qutput LR |
— — |V 1 Ch\Ejercicios_SDBW\Ejercicio 3-14ej3_1.uvprojx
compiling Uti ~
compiling sys 2 Di\Datos\Docencia\SDM\2015_16\EjemplosipvSiprueba.uvprajx
linking... 3 D:\Datos\Docencia\sDM\2015_16\Ejemplos\04_1_GPIO\Prueba_GPIO.uvpraojx
Program Size:
"oy Objeetshedd_l.axf" - 0 Error(s), 0 Warningis).
Build Timwe Elapsed: 00:00:01 =

Rebuild all target files ULIMEZ/




PASOS EN LA CREACION DE UN PROYECTO

o Durante la compilacién vera aparecer mensajes en la ventana inferior
del programa, y finalmente un mensaje diciendo el nimero de errores

=
. . (0]
y avisos (warnings) resultantes. 3
. yd . . B
o Una vez conseguido O errores, esta listo para ejecutar el proyecto 2
(o))
K2 CoEjercicios_SDEMEjercicio 3-Thej3_1.uvprojx - piision - X 0
File Edit Wiew Project Flash Debug Peripherals Tools 5VCS5  Window Help Z
IR Y || | &= F | @ JRe Qe z
£ E e ¥ | Target R AR SO &
Project U x | 1 principal.c v & =
=7 Project: gj3_1 1/%* Ejemplo de uso del LCD =%/ ~ g
=32 Target 1 2 Q
=55 Source Group 1 3 #include "Biblioteca SDM.h" 8

L. 4 #include "Utiles 3IDM.h"
] principal.c 5 - g
] Utiles_SDM.c & int mwain(wvoid){ 5
] Biblioteca_SDM.lib 7 Init SDM(): 8_
& cusis g Init LCD(}: o
" . =l (9]
=% Device 10 while (1) { @
J startup_stm321Txe_md.s 11 LCD Limpia(): >
] system_stm32ITocc 12 LCD:PrEparaBarras (O, ON, ON, ON):; 5
i 13 LCD_Texto (MUMOM) ; Q
14 espera (50000007 ; (@]
K1 | | 15 LCD Limpiai) : v ©
=] Project] @B-:--:-I's {} Func..| Oy Temp...| || € > 8
]
Build CQutput B g}
assenbling startup Stm3Zllxx md.s... ~ o
compiling system stm3zllxx.c... E

linking...
Program Size: Code=6444d4 RO-dats=348 RW-data=32 ZI-data=1632

l.axf" - 0 Erroris), 0 Warningi(s) .
Euild Timwe Elapsed: 00:00:00 =

ULINE2/1




PASOS EN LA DEPURACION DE UN
¢ PROYECTO
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() PASOS EN LA DEPURACION DE UN PROYECTO

o Una vez compilado correctamente, conecte la placa al USB y ejecute el depurador
con el botén: @)
« Tardara bastante hasta que cargue y luego aparecera un aviso del modo de evaluacion.
Pulse Aceptar. -
o S se abre una ventana con ensamblador, pulse |[#| para cerrarla.

o Como puede ver, el programa se ha ejecutado hasta llegar a la funcién main(). La
flecha amarilla indica el punto del programa donde se encuentra la ejecucion

E D:\JDSE\DG_CARMUrso_A(ademi[D_wM_SEgun_d_anrE_SistEmas_DigitaIES_EasadEs__En_M|'|:rcnrpD(E;ador_SDBM\}_EiEmElus_Pmdims_de_la_Tecn'a\ =l
| Eile | Edit Wiew Project Flash Debug Peripherals Tools 3SWVCS  Window Help
NEWd@ s uBl9c|e|RRRR|ESF Hae|@e o e|E])
HEolaee-n > D &ESE)
Registers L] ] prindpalc | ] startup_stm32ilnCmd.s » x | GPIOB 1 [E|
Register IVaIue =l 1 /** Ejemplo de usoc del LCD **/ = | i’ |
T ces 5 HVisian - -
- 3 #include "Biblioteca S5SDM.h"
4 #include "Utiles_SDM.h"
3
6 int main(void){
B 7 TInic SDM(): . EWVALUATION MODE
) | TR0 / l % Running with Code Size Limit: 32K
o RT 00000000 10 while (1) {
- RE eD0D00000 11 LCD Limpia();
iz LCD_PreparaBarras (ON, CN, ON, ON);
i3 LCD_Texto ("UNO") ;
14 espera (5000000)
is LCD_Limpia();
R13(5P) 16 LCD_PreparaBarras (0N, OFF, ON, OFF);
B R14(LR) 17 LCD_Texto ("DOS") ;
o R15 (PC) i8 espera (5000000) ; i
2R PSR 19 LCD Limpia();:
[+ Banked 20 LCD PreparaBarras (ON, CN, OFF, CFF):
[ System 21 LCD_Texto ("TRES");
LIS -l 22 espera (5000000) ; 2
[ project | = Registers < | 1L | 2
Command n @ Call Stack = Locals n @
Running with Code Size Limit: 32K - Name Loc.. Type

Load "D:\\JCSE\\06_CRRLCS_IIII\\1_Curso_Academico_2015_2016\\4_Segundo_Cuatrimestre
= - - = = - - = % main 0:00... |intf()

#% Restricted Version with 32768 Byte Code Size Limit
#% Currently used: 6824 Bytes (20%)

Ws 1, ‘i i
< m | »

>

ASS5IGN BreakDisable EreakEnable BreakKill BreakList BreakSet BreakRAccess COVERAGE |-l§_‘|CaII Stack = Locals | Watch 1 @Tlace Exceptions @E-.-ent Counters | EE Memory 1

ST-Link Debugger t1: 0.00030370 sec L7 €1 CAP| NUM SCRL OVR R/W

2 Nl EEREETTVIREE, I i B

9T0Z/T0/8T
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(L) PASOS EN LA DEPURACION DE UN PROYECTO (1)

o Para depurar, se pueden utilizar las siguientes opciones:

» 1) Ejecutar de corrido todo el programa desde el punto actual.
S1 hay puntos de ruptura, se para en ese punto

e 2) Se depura la funciéon actual, pero sin entrar en ella &

* 3) Se ejecuta todo el programa hasta el punto donde
actualmente se encuentra el cursor “{}

* 4) Se depura la funcion actual, entrando en ella, si es necesario ¢

e 5) Se sale de la funcion actual (se ejecuta lo que queda de
funciéon y se pausa la ejecucion al finalizarla). Solo funciona
cuando se ha activado la anterior previamente {3

o Ademas, puede poner un punto de ruptura (breakpoint, es
decir, pausa la ejecucién cuando llega a ese punto)
haciendo doble clic en cualquier punto a la 1zquierda del
numero de linea.

e Aparecera un circulo en rojo.

» Si se vuelve a hacer doble clic, se quita el breakpoint.

9T0Z/T0/8T
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PASOS EN LA DEPURACION DE UN PROYECTO (2)

o Para examinar el valor de una variable, abra una Watch
Window (View» Watch Windows®» Watch 1)

* En la parte inferior derecha, junto con Call Stack y con Memory 1 se
abre una nueva pestana denominada Watch 1

* En dicha pestana, escriba el nombre de la variable, registro o conjunto
de registros.

o Por ejemplo, escriba RCC y vera una estructura completa con los registros
del reloj

» En cada variable se puede ver su valor (so6lo s1 se entra en la funcion
donde se ejecuta) o incluso modificarlo para que sea tenido en cuenta
en el siguiente paso de ejecucidn.

o Para ver los registros asociados a los periféricos o modificar su
valor, seleccione la opcién “Peripherals P System Viewer” y
ahora haga visible el registro deseado (por ejemplo: GPIO ->
GPIOB)

» Por ejemplo, active el LED verde y rojo en PB6 y PB7, activando los
bits BS6 y BS7 del registro BSRR en GPIOB o desactivelos activando
los bits BR6 y BR7 de dicho registro (cuando el depurador esté dentro

de la funcion WHILE(1) a

9T0Z/T0/8T
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PASOS EN LA DEPURACION DE UN PROYECTO (3)

{3 D:JOSE\06_CARLOS I Curso_Academico_2015.2016\4_Segundo_Cuatrimestre Sistemas_Digitales_Basados_en_Microrpocesador_SDEM\3_Ejemplos_Practicos_de_la_Teoria\ T T | - G

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

NMSd@| » B9 o|@o | pRAR 1= Iz | @ lae(@ e o &[T 5
: ==l I = - = 5 P
‘Eol vy [DRBEQEID-2-8-3- 8- - S
Registers 1B ] principal.c v X | GPIOB 1B B
I Value = 4 #include "Utiles_SDM.h" - |Z| S
=]

Ox00000001 6 int main(void){ Property Value (o))

(42048108 7 Init SDM();: = Bsil | =]
00000011 8 Init LCD{): BS10 | v
40002404 9 B | 44
00000000 [ 10 wnile (1) { BS8 r 2
20000020 11 LCD Limpial); D
00000000 12 LCD PreparaBarras (ON, ON, ON, ON); Bs7 r 3
00000000 13 LCD_Texto ("UHO"); BS6 - Q
00000000 1] 14 espera (5000000) ; 3 BSS r n
00000000 15 LCD Limpial(): BS54 r Y
02001488 i 16 LCD PreparaBarras (CN, OFF, CON, CFF): 6
00000000 17 LCD_Texto("DOS") : B3| =
20000060 18 espera (5000000) ; BS2 - o))
20000680  _| 139 LCD Limpial(): BS1 - 6
03000559 ] 20 LCD PreparaBarras(CN, OM, OFF, OFF): B0 - wn
02001390 21 LCD Texto("IRES"): B o
21000000 22 espera (5000000) ; LCKR 000000000 ~| )
- Banked 23 LCD_Limpia(): BS6 4
[ System | 24 LCD PreparaBarras(0FF, OFF, ON, CN): [Bit6] WO (@ 0x40020418) Port x set bity g
[ttt = 25 LCD Texto ("HMRAMBO™): i (y=0.15) o
[l Project | = Reaisters < LI} | > )
Command 0 @ watch1 n @ g

Running with Code Size Limit: 32K +  Name Value Type

Load "D:“\\JOSE\\06& CARLOS_ IIII\%\1 Cursc_ Academico 2015 2016\\4_Segundo Cuatrimestre @ _uchar - g
- (@)
##% Restricted Version with 32768 Byte Code Size Limit 5% Rec 040023800 [FEEED 3
##%% Currently used: 6824 Bytes (20%) @ CR 0:03030303 unsigned int o)
@ ICSCR 0:005D0D06E unsigned int 8
Ws 1, "1 - @ CFGR 0x0091000F unsigned int 8
< m | I v R 0x00000000 unsigned int »
> @ AHBRSTR 0500000000 unsigned int g_
ASSIGN BreakDisable BreakEnable BreakKill BreakList BreakSet BreakBAccess COVERAGE | ¥ APB2RSTR 000000000 unsigned int LI (@)
=

5T-Link Debugger t1: 0.40413890 sec 10 C1 CAP NUM| SCRL OVR R/W

G el o
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PROYECTO EJEMPLO PARA PROBAR EL LLCD DE LA PLACA

[** Ejemplo de uso del LCD **/

#include "Biblioteca_SDM.h* &
3
int main(void){ S
Init_SDM(); =
Init_LCD(); 2
while (1) {
LCD_Limpia();

LCD_PreparaBarras(OFF, OFF, OFF, ON);
LCD_Texto("UNQO");

LCD_Limpia();
LCD_PreparaBarras(OFF, OFF, ON, ON);
LCD_Texto("DOS");

LCD_Limpia();
LCD_PreparaBarras(OFF, ON, ON, ON);
LCD_Texto("TRES");

LCD_Limpia();
LCD_PreparaBarras(ON, ON, ON, ON);
LCD_Texto("MAAMBQO");

lopesas0.1doidi\ us sopeseg sajenbiq sewalsis
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EJERCICIOS

o 1) Cree el proyecto ejemplo y depurelo.

o 2) Ejecutelo de forma seguida. (Ve algo en el display si1 lo
ejecuta de forma seguida?.

o 3) Entre mensaje y mensaje en el LCD introduzca una

espera de 1 segundo para poder ver algo, utilizando para
ello un bucle for (intente ajustar en numero de ciclos del

bucle for para que cada espera sea de 1 segundo) . Para

ello, tenga en cuenta:

o Que cada instruccion en ensamblador se ejecuta en un tunico ciclo de
reloj.
o Que cada instruccion en C son varias instrucciones en ensamblador.

o Que el reloj esta funcionando a 32MHz.

o 4) Cambie el programa para que la funciéon for creada esté

dentro de una libreria llamada “utiles.h” y sea mas
elegante.

9T0Z/T0/8T
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